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1. Introduction 
The National Highway Institute (NHI) Web-based Training (WBT) Standards Guide 
provides specific guidance to the development of WBT courseware.  
 
Refer to your RFP for specific guidance on your specific project. Please refer any 
deviations from this document to your COTR. 

1.1. Taxonomy and Course Structure 

NHI WBT courseware is developed using the following structure: Course, Module, or 
Lesson. 

Web-based Training 
 

Module A  Module B 

Lesson 1 Lesson 1 

Lesson 2  Lesson 2  

Lesson 3  Lesson 3  

Lesson 4  Lesson 4  

 
 
All courses will include modules; lessons are optional. For purposes of the Sharable 
Content Object Reusability Model (SCORM), a sharable content object (SCO) is defined 
at the module level.  
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1.2. General WBT Development Information 

This section covers general development guidance for NHI Web-based training.  For 
additional resources, templates, and examples, refer to the NHI WBT Developer Toolkit 
at www.nhi.fhwa.dot.gov/resources/wbt_developer.aspx.  
Use the following general standards. 
 Provide learners with information in the fewest steps and shortest time possible. 

The duration is measured by the amount of time it takes an average learner to 
read all the presented material, access provided options, and listen to all 
included audio. 

 Convey the content in simple and direct language using simple terms. 
 Maintain module and lesson consistency. 

− Develop module and lesson welcome screens that illustrate the relevance of 
the content to the learner. 

− End each lesson with a summary that recaps the content and ties it to the 
learning outcomes. 

 Create a desire to learn by beginning each module and lesson with something 
compelling. 

 Include transitions to ensure coherent flow between screens. 
 Address one concept, procedure, or item of instruction on each page. 
 Correlate information on the screen to the slide title. 
 

1.1.1. Platform Standards 
Because NHI does not have control over consumers’ training platforms, the following 
standards were developed internally and represent the baseline for online courseware. 
All courseware must be designed for use on the minimum platform configurations. 
 

1.1.2. Hardware  
Minimum hardware configurations for development are shown below. 
 Minimum operating system: Windows 7 or higher 
 Minimum processor speed: Intel Pentium III or higher 
 Standard screen resolution: 1024x768 
 Video card: 32 bit 

 
1.1.3. Browser Specification 

Design courseware for optimal viewing using the standard FHWA configuration browser.  
 Internet Explorer 6.0  
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 Flash Player 8 or higher 

To compare the settings listed above with those established by Adobe, please visit 
www.adobe.com/products/adobeconnect/tech-specs.html. 
 

1.1.4. Hosting 
All NHI WBT courseware resides on the FHWA server at http:/fhwa.adobeconnect.com.    
 

1.3. Development Tools  

All WBT developed for NHI must use Adobe Presenter 7, a PowerPoint to Flash 
conversion tool. Developers must purchase a developer‘s license for Adobe Presenter 7 
and the Presenter plug-in.  
Be sure that all developed products use the latest version of the NHI WBT template, 
which is available on the NHI Web site 
www.nhi.fhwa.dot.gov/resources/wbt_developer.aspx.  
Other non-proprietary development tools that may be used in conjunction with Adobe 
Connect are: 
 Adobe Flash (version 8 or later). 
 JavaScript. 
 Adobe Photoshop. 
 Adobe Premiere. 
 Adobe Captivate. 
 Adobe Acrobat. 
 
Any other development tools require approval from the COTR.  The developer should 
verify that they have the correct version of the NHI template with the NHI TPM prior to 
beginning courseware development. 
 

1.4. Courseware Testing  

The developer must ensure compliance with NHI standards, SCORM, and Section 508 
when possible.  To support compliance and confirm an acceptable product, NHI 
developed the following testing process.   Among other things, the testing process 
requires: 
 Alpha tests all supported operating systems and browsers. 
 LMS integration testing. 
 Quality control testing on published versions of alpha, beta, and final courseware. 

http://www.adobe.com/products/adobeconnect/tech-specs.html
http://fhwa.adobeconnect.com/
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The duties assigned to the contracted developer are listed.  Developers should refer to 
the task order for any specific testing requirements or modifications to this process. 
Prior to beginning courseware development, the developer should contact the NHI TPM 
in order to obtain a folder on the NHI Adobe Connect server.  The NHI TPM will provide 
the necessary information on how to complete this process.   
Developers are assigned a folder on the NHI Adobe Connect server in order to 
complete the testing process outlined by NHI.   
This folder is to be used for development and testing purposes only.  
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1.1.5. Developer Duties During Testing Processes 
 
Stage Stage 1  

Alpha 
Stage 2  

Pilot 
Stage 3  

Soft Launch 
Stage 4  

Public Offering 
Developer 
(Contractor) 
Duties 

• Publishes WBT courseware to 
developer folder on the NHI 
server as shared content and 
conducts quality control. 

• Notifies NHI when courseware 
is ready for review and 
provides links for accessing 
courseware. 

• Reviews comments submitted 
by Tech Panel lead.   

• Implements changes and 
documents final resolution of 
all comments. 

• Submits “Final Resolution of 
Comments” form to NHI and 
Tech Panel lead. 

• Obtains session ID from NHI 
for formatting PTG link   
Provides NHI with all ancillary 
source files, which are 
published by NHI to course 
folder, and receives hyperlinks 
to embed in WBT.1 

• Publishes revised courseware 
to vendor folder on NHI 
server as shared content and 
retests to make sure 
materials are pilot-ready. 

• Notifies NHI TPM with a 
written, signed report that the 
product complies with NHI’s 
“pilot-ready” criteria and 
documents their testing 
process.  

• Reviews comments submitted 
by Tech Panel lead following 
pilot.   

• Implements pilot 
recommendations and 
documents final resolution of 
all pilot comments. 

• Submits “Final Resolution of 
Pilot Comments” form to NHI 
and Tech Panel lead. 

 

• Publishes post-pilot 
revised courseware to 
vendor folder on NHI 
server and retests. 

• Notifies NHI TPM & ISD 
that courseware is ready 
for internal NHI testing. 

• Reviews comments 
submitted by NHI Systems 
Support.   

• Implements Systems 
Support recommendations 
and documents final 
resolution of all soft launch 
recommendations. 

• Submits “Final Resolution 
of Soft Launch Comments” 
form to NHI TPM, ISD, and 
Systems Support. 

 
 

• If changes were 
necessary from Stage 3 
Soft Launch, republishes 
revised courseware, 
maintaining original links, 
and submits source files 
to NHI TPM & ISD 
following guidelines 
provides in the NHI WBT 
Standards Guide. 2 

• Removes all draft 
materials published to 
vendor folder on the NHI 
server. 

 
 

                                                
1 This step should be guided by NHI.  NHI may choose to have vendor publish all courseware in vendor folder and only move ancillary files from vendor 
folder to course folder at the end of the development when all courseware is final. 
2 It is possible that following the Stage 3 review by Systems Support that no changes would need to be made by the vendor and that the materials would 
be accepted as final at that point.   
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2. Standards for Design Plans  
Design plans contain the findings and recommendations that are usually the 
result of a needs analysis. Design plans ensure the course is instructionally 
sound, which means it is job-relevant, task-based, problem-centered, interactive, 
engaging, and well organized.  
Depending on the project, the design plan may be completed in a series of 
iterations, beginning with a high-level design plan (HDP) that details basic course 
content and a course overview. It is then expanded to a more detailed-level 
design plan (DDP) that may include an extensive content outline, explanation of 
instructional activities, information on graphics and resources to be used, and an 
overview of the assessment. Refer to the development contract and the NHI TPM 
for additional clarification on what should be included in design plans. 
Design plans typically contain the following information.   
 Introduction and background 
 Statement of business need 
 Target audience characteristics 
 Course goal(s) 
 Course learning outcomes (terminal learning objectives, required; enabling 

objectives, optional) 
 Overarching instructional approach, i.e., theme, metaphor 
 Delivery method(s) 
 Course structure (diagrams of modules that show chunking and sequence 

of instruction) 
 Use of media (animation, audio, video), if recommended 
 Description of instructional strategies 
 Estimated course duration, by module  
 Content and exercises mapped to each course learning outcome (in 

bulleted or outline format)  
 Description of graphics designated to enhance content  
 Proposed use of narration, if applicable 
 Identification of prototype content 
 Projected timelines for tasks and milestones, if not already provided in a 

project management plan or other documentation 
 Evaluation strategy and traceability document  

− The traceability document supports the end-of-course assessment as 
a Level 2 evaluation.  
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− The traceability document will allow NHI to quickly and easily 
determine validity of the Level 2 instrument, as well as facilitate later 
updates of content. It will identify, by objective, that the assessment 
item effectively tests learner mastery of an objective and the location 
in the courseware of supporting content. 

− The traceability document is required for SCORM compliance.  It may 
be collected as a separate final document or revised as part of an 
update to the overall design plan.  Confirm with the NHI TPM as to 
how this document is to be delivered. 
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3. Standards for Storyboards  
A storyboard is a draft version of Web-based courseware created for the purpose 
of review.  A storyboard presents content sequentially, segmented in accordance 
with the detailed-level design plan (DDP).  The storyboard allows reviewers to 
confirm technically accurate and sufficient content is being presented via text, 
narration, on-screen graphics, or another medium.  It also allows NHI to confirm 
that the developer is correctly applying 508 guidance and Adobe Presenter Quiz 
settings to the courseware. 
The development of storyboards is project dependent.  The development 
contract will dictate whether storyboards are required as part of courseware 
development. 
The designer or developer will create draft storyboards for each module that can 
include:  
 On-screen text. 
 Visuals, such as royalty-free photos, diagrams, or descriptions of planned 

Flash animation. 
 Narration script. 
 Video. 
 Script for new video. 
 Captivate demonstrations. 
 Knowledge checks and debrief slides. 
 Embedded links. 
 Rough cut (scratch) audio. 
 End-of-course assessment questions and answers. 
 
Storyboards are delivered as unpublished content, typically as a PowerPoint file.  
The developer should confirm with the NHI TPM that this is the preferred delivery 
method for this deliverable.  
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4. Standards for Prototypes 
The prototype provides a functional sample of the content designed and 
developed in accordance with the WBT standards and instructional strategies 
identified in the detailed-level design plan (DDP). A prototype of a lesson, 
module, or content segment allows reviewers an opportunity to verify that the 
presentation of the content coincides with the detailed-level design plan (DDP).  
Changes at this stage are considerably less time, and cost intensive than later in 
the development process. 
Developers will designate a specific lesson as the prototype in the detailed-level 
design plan (DDP).  A prototype usually contains an average of 15-20 screens. 
Rationale for selection of prototype content may include: 
 Content for the section is the most stable or best documented in the 

material. 
 All functionality to be included in the project is included in the section. 
 The content is the foundation for other content in the project, and its 

development will facilitate the development of other content. 
 
The prototype must be delivered to NHI as a published file. The purpose of the 
prototype is to illustrate the presence of the following. 
 Creativity 
 Level of interactivity 
 Opportunities for practice 
 Writing style  
 Understanding of adult learning principles 
 Adherence to standards 
 Accuracy of content 
 Treatment of content 
 Resources, such as: 

− Cited documents 

− A bibliography 

− Relevant web resources  

− Similar items 
 
Depending on the project, a series of prototypes may be appropriate.  Examples 
include courses that contain simulations or the use of virtual world technology. 
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5. Standards for Using the WBT PowerPoint Template  
The NHI template establishes the graphical user interface (GUI) for WBT 
courseware. Use the NHI template to develop a WBT.  
Retrieve the template from the WBT Developer Toolkit at 
www.nhi.fhwa.dot.gov/resources/wbt_developer.aspx. Developers should verify 
that they are using the preferred template before any development work begins. 
General style and standards guidance on the development of PowerPoint slides 
exists in the NHI Style and General Standards Guide, and should be followed 
when using the NHI template. 
All screen layout standards are already incorporated into the templates.  Any 
requests for modification to the template must be provided in writing to the NHI 
point of contact for the course, and must be approved by the COTR. 

5.1. Screen Layout Standards 

Media standards are used to maintain style consistency within the following 
areas.  

5.1.1. Screen Design 
 Establish a specific location for the presentation of instructions, completion 

times, and prompts. 
 Provide recurring information in consistent locations. 
 Use white space to separate blocks of text. 
 Create the shortest module and lesson titles needed to convey meaning. 

5.1.2. Text Layout 
 Present information in a top down, left to right instructional format. 
 Layout content so a screen reader will read the text and alt tags in the 

correct order. 
 Design text layout in short segments or phrases. 
 Break up blocks of text to make it easier for the learner to scan the 

content. 
 Use bullets, numbered lists, tables and charts to break up lengthy 

sentences. 

5.1.3. Navigation  
Use consistent navigation standards to promote learner satisfaction and 
retention. The following standards apply to all Web-based courseware. 
 Ensure intuitive, learner controlled navigation. 
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− Buttons should have text description labels (alt tags) that include the 
URL or slide number. 

− Navigation buttons must display in the same position on every page. 

− Mouse cursor changes and rollover highlights must be consistent 
within a course. 

− Other navigational buttons may be added, as appropriate. However, 
the location of navigational buttons is specified in the template. Make 
buttons, such as Submit, Play, and Replay, consistent within each 
course. 

− Navigation elements provide one-click access to learners.  Examples 
include Resources, Help, and Glossary. 

 Provide clear instructions or cues for all required learner activities.  
 Allow modules and lessons to be completed in any order unless the 

instructional design requires sequential accomplishment. If sequential 
accomplishment is required, provide instructions to the learners.  

 Document links to other pages within the course or to external Web pages 
or other sites. 

− Describe internal links in the narration. For example: “For more 
information, please navigate to slide 38.” 

− Otherwise, place linked slides directly after the slide that references it 
so that a user navigating with only the keyboard can access the 
information in a logical way.  

− Document external links in the outline and include the link description 
in the narration. 

 External links should be used sparingly as to not distract from existing 
content.  

5.1.4. 508 Considerations 
 Creating a 508-compliant WBT requires production of a compliant 

PowerPoint product.   
 It is ultimately the job of the development team to ensure that all 508 

compliant checkpoints are met and that the materials are developed in 
compliance with the law. The following sites provide the most current 
government guidance: 

− www.section508.gov 

− www.webaim.org.  

 

http://www.section508.gov/
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5.1.5. Font 
The following font sizes should be applied when using the WBT PowerPoint slide 
template. 
 

Content Type Font Size 

Headings on PowerPoint slides (course title, 
lesson title, screen title) 

Arial 16-18 pt. bold 

Text on PowerPoint slides Arial  16-18 pt.  
 
Follow NHI general standards on readability as found in the NHI Style and 
General Standards Guide. The PowerPoint template for WBTs is preset with 
approved colors and styles. Use of other font type, size, or color must be 
approved by the NHI TPM. 
 
 

  

Slide Text 
Arial 16 pt. 

 

Course Title 
Arial 18 pt. bold 
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6. Standards for Media 
Media standards provide a consistent look and feel to courses. They also 
increase the likelihood that the media will function as intended on the training 
platform. 
For each lesson, utilize the most suitable medium to support and reinforce the 
subject material or interactive components. Media include computer graphics, 
photographs, video, animation, and graphs or tables.  

6.1. Graphics  

Refer to the NHI Style and General Standards Guide for general graphics 
requirements. 
 Use custom illustrations and interactions to teach complex concepts.  
 Recreate tables and graphs wherever possible instead of inserting as an 

image.  Scanned graphics should be avoided entirely. 
 Use the most modern technology generally available to generate visuals, 

including computer-generated graphics. 

− Be aware that any computer software required for the visual aids 
must be readily available to any facilitator; do not use proprietary 
software. 

 Alt tags for charts and other complex graphics should reflect their 
complexity.  A sentence or two will not always be sufficient. 

 Data presented in tables must be included in the general narration or 
provided as a table description.  

− The information or data must make sense when presented in a 
narrative format. Redundant or repeated information should be 
presented logically and not simply repeated. 

6.2. Audio 

 Avoid phrases that are not meaningful on their own or apply only to a 
select group of users.  

 Include a semi-colon after each item in a narrated list, add the word “and” 
after the penultimate item, and place a period after the last item. This 
ensures that a screen reader can identify the items as a list. 

 Avoid special characters in the narration (notes) section; they will not 
publish properly in Adobe Presenter. 

 Ensure audio volume levels are consistent throughout the course. 
 Use one audio talent to narrate all modules within the same course. If 

presenting a role-play scenario, multiple voice talent may be used, but 
roles must be consistent. 



          NHI WBT Standards Guide 
 

 

 Include the following audio edits. 

− Place 1 second of silence at the beginning of every slide. 

− Place 1 second of silence at the end of every slide. 

6.3. Video 

 Avoid techniques such as zooming, panning, transitional wipes, dissolves, 
and fast motion subjects. 

6.4. Animation 

 Allow user to control the animation to include start, stop, and replay. 
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7. Standards for Interactivity 
Exercises, calculations, skill practice, and other experiential work provide an 
opportunity to test understanding and relate training content to work-related 
scenarios.   
Depending on the goals or needs of the project, it may be appropriate to design 
modules within the same course to include varying levels of interactivity. For 
example, supplement foundational principles with complex, branched case 
studies for application of those principles.  
NHI’s stance on levels of interactivity is as follows: 

Level of Interactivity Description 
Level I – Passive The learner acts solely as a receiver of 

information. The learner progresses linearly 
through course reading text from the screen, 
viewing video or listening to audio.  
 

Level II – Limited 
Interaction 

The learner makes simple responses to 
instructional cues. The responses may include 
answering multiple choice or true/false 
questions.  
 
Example: Knowledge Checks 
 

Level III – Complex 
Participation 

The learner makes a variety of responses 
using varied techniques in response to 
instructional cues.  
 
Example: Building a model/diagram from 
available parts. 
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8. Standards for Assessments 
Informal and formal assessments are developed and administered as part of 
Web-based training.  NHI uses knowledge checks and course evaluations as part 
of its informal assessment process.  Formal assessments are referred to as end-
of-course assessments.   
Knowledge checks provide practice opportunities to reinforce each concept or 
skill. Practice exercises are evaluated but the scores are usually not sent to the 
learning management system.  
Course evaluation data measures the participants’ training experience.  The 
course evaluation is made available via an external link at the end of the training.   
Some WBTs also include end-of-course assessments that evaluate participants’ 
mastery of the content.  End-of-course assessments are loaded to the online 
curriculum.  Participants are instructed to complete the exam at the end of the 
training.  Instructions on completion requirements can be provided in the final 
training module as needed.   
If an end-of-course assessment is required, use Adobe Presenter Quiz Manager 
to create the exam as one quiz with multiple questions in a separate PowerPoint 
file. The end-of-course exam template can be found at: 
www.nhi.fhwa.dot.gov/resources/wbt_developer.aspx 
 

8.1. Traditional Test Methods 

Assessment instruments could include objective measures, e.g., multiple choice 
questions, matching questions. Other acceptable testing types include 
performance testing (skill demonstrations) and critical thinking (case studies).   
Some acceptable test types are described in the table below. 

Test Item Type  Characteristics  

Multiple-choice   Useful for testing knowledge and cognitive abilities. 
 Consists of a stem and a selection of possible 

responses. (Answer scan sheets accept up to five 
possible responses.) 

Matching   Useful for testing terms and labels.  
 Consists of two columns of related words, phrases, or 

symbols to be matched by the student.  

True/False   Useful for testing knowledge.  
 Consists of a single statement.  
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Test Item Type  Characteristics  
 Note: Use no more than 10% true/false questions. 

Completion or 
“fill in the blank”  

 Useful for testing recall of knowledge committed to 
memory.  

 Consists of a statement from which a word(s) or short 
phrase has been omitted. The student must supply the 
missing word(s) or phrase in the blank(s) provided. 

Performance   Useful for testing job tasks and skills.  
 Consists of a simulated or actual environment with 

certain conditions of performance and certain expected 
outcomes.  

 

8.2. Standards for Knowledge Checks  

When establishing a knowledge check: 
 Provide a “hint” if the learner answers incorrectly on the first try.  
 Provide corrective feedback to help enable learning if the learner answers 

incorrectly the second time.  
 
Example of a Knowledge Check with generic feedback 
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8.3. Adobe Presenter Settings for Knowledge Checks  

Knowledge checks are created using the Adobe Presenter Quiz Manager.  
 
Each knowledge check is created as a separate quiz with one question.  A WBT 
with five knowledge checks will reflect five separate quizzes in the quiz manager 
with one question assigned to each. 
 

8.3.1. Quiz Manager Settings 
Use the following steps to set up a knowledge check.  
 
Note that you must set up a quiz before you can enter the questions. 
 
1. Open the Quiz Manager window by selecting Adobe Presenter  Manage. 
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2. Select the Output Options tab.  All boxes should be deselected. 
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3. Select the Reporting tab. 

4. Deselect Enable reporting for this presentation. 
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5. Select the Default Labels tab. 

6. Select all boxes under Default question feedback. 

7. Enter the following text: 

 Correct message field “Correct. Advance to the next slide for a debrief. 
Select anywhere to continue.” 

 Incorrect message field “Incorrect. Advance to the next slide for a 
debrief. Select anywhere to continue.” 

 Retry message field “Incorrect. {Add hint feedback on slide} Select 
anywhere to try again.” 

 Incomplete message field “You have provided an incomplete answer. 
Select anywhere to try again.” 
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8. Select the Appearance tab. 

9. Apply the following settings to Fonts. 

 Question: Arial 16, bold  

 Answer: Arial 16 

 Button: Arial 16 

 Message: Arial 16 

10. Apply the following settings to Button placement. 

 Orientation: Horizontal 

 Position on slide: Bottom right 

11. Select Apply formatting to all existing quizzes. 
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12. Select the Quizzes tab. 

13. Select Edit in the Quiz to open the Quiz window. 
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14. Select the Quiz Settings tab. 

15. Enter “Quiz” in the Name field.  

16. Select “Optional – the user can skip this quiz” from the Required dropdown 
field.  

17. Apply the following to Settings. 

 Select Allow backward movement 
 Select Allow user to review quiz 
 Deselect Include instructions slide 
 Deselect Show score at end of quiz 
 Select Show questions in outline 
 Deselect Shuffle questions 
 Deselect Shuffle answers 
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18. Select Question Review Messages… button to open the window. 

19. Enter the following text: 

 Correct field “You answered this question correctly.”  

 Incomplete field “You did not answer this question completely.” 

 Incorrect field “Incorrect. The correct answer is:…”  

20. Select OK to close the Question Review Messages… window. 
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21. Select Pass/Fail Options tab. 

22. Select 0% or more of total score to pass.  

23. Select “Go to next slide” from the Action dropdown field under If passing 
grade.  

24. Select “Infinite Attempts” under If failing grade.  

25. Select OK to close the Quiz window and return to the Quiz Manager window. 
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8.3.2. Question Settings 
After you have set up the quiz, you can create the question(s) for the quiz.  
 
Remember that for each knowledge check you need set up one quiz and one 
question. 
 
1. Open the Quiz Manager window by selecting Adobe Presenter  

Manage. 

 
 

2. Select the Quiz to which you are adding a question. 

3. Select the drop down arrow next to Add Question. 
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4. Select the type of question indicated in the dropdown menu. 
  

 
 
Note: The remaining steps and settings described in this section can be 
universally applied to all of the question types.  This guide will use the multiple 
choice question type to illustrate each step. 
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5. Select Question tab. 

6. Enter the following text in the Name field “Learning Outcome {x}.” Indicate 
which Learning Objective the question addresses. 

7. Enter the following text in the Question field “Knowledge Check.” 

8. Enter the following text in the Score field “0.” 
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9. Select the Add button under Answers.  

 Enter, or copy and paste, the text for the answer options.  

 Select the correct answer(s). 

10. Select either “Single response” or “Multiple response” from Type dropdown.  

11. Select the lower case characters (a, b, c, . . .) from the Numbering 
dropdown.  

 

7 Select the Options tab, and set the following: 
 In the Type section: 

− Select Graded – there are right and wrong answers from the  
− Select Show clear button 

 In the If correct answer section: 
− Select Go to next slide from the Action dropdown 
− Select Show correct message 

 In the If wrong answer section: 
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− Enter 2 in the Allow user field (Set to 1 for True/False or Yes/No 
questions.) 

− Select Go to next slide from the Action dropdown 
− Select Show error message 
− Select Show retry message 
− Select Show incomplete message 

8 Select the Reporting tab and deselect Report answers 
9 In the Question window, select OK. 
10 In the Quiz Manager window, select OK. 
11 Repeat for each knowledge check. 
 

8.3.3. Question Formatting on PowerPoint slides 
After a Quiz is created in the Adobe Presenter Quiz Manager, the text will not 
use the same size font or color as the master slide so the font and color must be 
altered manually.*  
 
Step Action 
1  Add the Question to the slide in a separate text box 

 Set font to Verdana 22 pt Bold 
 Align to top-left of grid 
 Set color to BLACK 
 Set RGB color 0, 0, 0  

2  Set answer font to Verdana 20 pt 
 Set RGB color 0, 0, 0  

3 Format answers if needed.  
 Select all answers by holding the SHIFT key and clicking each text box.  
 Select Format > Object 
 On the TEXT BOX tab, un-check “word wrap text in auto-shape”’. This will cause 

the text to continue off the page 
 Select the spot after the last word that fits within the grid and select the ENTER 

key while holding SHIFT. Complete for every line of text 

4 Format response boxes 
• Manually adjust the font and color of the response boxes 
• Set font to Verdana 20 pt and RGB color 0, 0, 0 
• Set box fill color to RGB 202, 212, 209 or the same color as the sub-navigation 

bar  
• Arrange the boxes so no answers are covered 

5 Format Submit and Clear buttons  
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• Set font to Trebuchet 14 pt and white color 
• Set box fill color to RGB 0, 51, 102  
• Place boxes in the lower-right corner of the screen 

 
*To avoid this extra step, create a separate master slide for quizzes to 
accommodate the different font sizes and colors. 
 

8.4. Standards for a Knowledge Check Debrief 

Knowledge check debrief slides allow Adobe Presenter knowledge checks to 
meet Section 508 compliance. Debrief slides are required after each knowledge 
check in order for Section 508 compliance to be met.  
In addition, the debrief slide provides an opportunity for documenting structured 
feedback on the correct and incorrect answers.   
Apply the following guidance when creating debrief slides: 
 Insert a debrief slide after every knowledge check. 
 Apply the Knowledge Check Debrief layout from the WBT template to 

format the slide correctly. 
 Match the knowledge check slide to the debrief slide in all content with the 

exception of: 

− Slide title. 

− Answer option buttons or boxes. 

− Question feedback buttons. 

− Navigation buttons. 
 Format answer options so incorrect answers are grayed-out.  Suggested 

color formatting for incorrect answers is Gray, RGB color 150, 150, 150. 
 Provide feedback on the answer options. 
 Record the correct answer in the narration at a minimum. 
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Example of Knowledge Check Debrief slides 
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8.5. Standards for End-of-Course Assessments  

An end-of-course assessment is created using the Adobe Presenter Quiz 
Manager.  
In order for students to qualify for Continuing Education Credits (CEU), the 
exams must have the following settings: 
 Every question is required. 
 There is no feedback. 
 Each answer is communicated back to the LMS and tallied. 
 The final score must be given to the student, who must score better than 

70% to pass. 
Given these constraints, this exam is not Section 508 compliant. Any learner who 
cannot complete the exam should contact NHI Training (NHITraining@dot.gov) 
and an NHI representative will proctor the exam for the student verbally. 
This version is not Section 508 compliant for several reasons. 
 A learner using the keyboard to navigate cannot select the different 

multiple choice options and the Submit button (the mouse must be used.) 
 A learner using a screen reader will not know what option has been 

selected. 
 Learners using either a screen reader or the keyboard to navigate (or 

both) will not be able to obtain a score. 
 

8.6. Adobe Presenter Settings for End-of-Course 
Assessments 

The end-of-course assessment should be created as one quiz with multiple 
questions in a separate PowerPoint file. 
 
You must set up a quiz before you can enter the questions. 

8.6.1. Quiz Manager Settings 
 
Step Action 
1 Open the Quiz Manager window by selecting Adobe Presenter  Quiz 

 Manage. 
2 In the Quiz Manager window, select the Output Options tab: 

 Deselect Display question list in quiz pane 
 Deselect Show incomplete quiz warning  

3 In the Quiz Manager window, select the Reporting tab, then select 

mailto:NHITraining@dot.gov
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Step Action 
Enable reporting for this presentation. Set the following: 
 Learning Management System: Adobe Connect Pro 
 Report Pass or Fail: Report status as defined by report data 
 Choose report data: Report to Adobe Connect Pro 
 Report score to LMS as: Score 
 Reporting level: Only report the score 
 
Select OK  

4 In the Quiz Manager window, select the Default Labels tab, and set: 
26. In the Default question button labels section: 

− Submit button text: Submit 
− Clear button text: Clear 

27. In the Default question feedback section: 

− Deselect Correct message. 
− Deselect Incorrect message. 
− Deselect Retry message. 
− Select Incomplete message, and enter: “You must answer the 

question before continuing.”  
5 In the Quiz Manager window, select the Appearance tab, and set: 

28. Fonts 

− Question: Arial 16  

− Answer: Arial 16 

− Button: Arial 16 

− Message: Arial 16 
29. Button placement 

− Orientation: Horizontal 
− Position on slide: Bottom right 

30. Select Apply formatting to all existing quizzes 

6 In the Quiz Manager window, select the Quizzes tab. 
7 Select Add New Quiz to open the New Quiz window. 
8 Select the Quiz Settings tab. 
9 In the Name field, enter {Course Name}. 
10 From the Required dropdown, select Answer all – the user must 

answer every question to continue 
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Step Action 
11 In the Settings section: 

31. Deselect Allow backward movement 
32. Deselect Allow user to review quiz 
33. Deselect Include instructions slide 
34. Select Show score at end of quiz 
35. Deselect Show questions in outline  
36. Deselect Shuffle questions 
37. Deselect Shuffle answers 

12 Select Pass/Fail Options tab and: 
 In the Pass/Fail options section, set 70% or more of total score to 

pass 
 In the If passing grade section, select Go to next slide from the 

Action dropdown 
 In the If failing grade section:  

− Set Allow user to 1 attempts 

− Select Go to next slide form the Action dropdown 

13 Select OK to close the New Quiz window 
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8.6.2. Question Settings  

After you have set up the quiz, you can create the questions. For the end-of-
course assessment, there is one quiz for the assessment, with multiple questions 
in the quiz.  
 
Use the step/action chart below to set up the quiz questions.  
 
Step Action 
1 In the Quiz Manager window, select the quiz to which you are adding a 

question, then select the drop down arrow next to Add Question. 
2 Select the type of question indicated in the storyboards, then select 

Create Graded Question. 
 
NOTE: The type of question used in this example is Multiple Choice. The 
inputs are similar for other types of questions, unless noted. 

3 In the {Type} Question window, the question section is similar for all 
questions types. Set the following: 
 Name field: Enter “Learning Outcome {x}” 

Note: Indicate which Learning Outcome/Objective the question 
addresses.  

 Question field: Enter assessment question, i.e. “What color is the 
banana?” 

 Score field: Enter the number of points for the question. 
Note: The total number of points for an end-of-course assessment 
should be 100. Distribute points as evenly as possible through all 
questions on the assessment, but only include 1 question per learning 
outcome.  

4 From the Type dropdown, select either single response or multiple 
responses, based on the storyboard. 

5 From the Numbering dropdown, select the lower case characters (a, b, 
c, . . .) 

6 In the Answers section, select Add, then enter the text for the answer 
options. Select the correct answer(s). 

7 Select the Options tab, and set the following: 
 In the Type section: 

− Select Graded – there are right and wrong answers from the  

− Deselect Show clear button 
 In the If correct answer section: 
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Step Action 
− Select Go to next slide from the Action dropdown 

− Deselect Show correct message 
 In the If wrong answer section: 

− Enter “1” in the Allow user field 
o Note: Set to 1 for all question types in the end-of-course 

assessment. 

− Select Go to next slide from the Action dropdown 

− Deselect Show error message 

− Select Show incomplete message 

8 Select the Reporting tab and select Report answers, then: 
 Select the {Course Name} from the Name dropdown. 
 Do not change the Interaction ID. 

9 In the Question window, select OK. 
10 In the Quiz Manager window, select OK. 

 

Standards for Course Evaluations 

NHI assesses the participant’s overall training experience using a standardized, 
online evaluation.   
The course evaluation is   
 Accessed by participants via an external link on one of the final screens of 

the training module (if no end-of-course assessment is included in the 
curriculum or is optional.) 

 Accessed by participants via an external link on the report screen of the 
end-of-course assessment. 

NHI will manage the collection and analysis of course evaluation data.  The 
developer can request copies of this data from NHI. 
Evaluation links are generated from the course number and the session number 
that are assigned by NHI. Please contact NHI for this information. 
The evaluation link should be formatted in the following manner:  

www.nhies.info/online-eval.html?coursenumber=[CMTS course 
number]&sessionnumber=[CMTS session number] 

Here is an example: 
https://www.nhies.info/online-
eval.html?coursenumber=134095&sessionnumber=20090601 
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If a course number incorporates a letter, e.g. 134095A, that letter needs to be 
capitalized in the PTG link in order to work correctly.   
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9. Standards for Publishing  
Use this section when preparing to publish WBT courseware.  The settings 
established in this section, in conjunction with the NHI WBT template, establish a 
consistent graphical user interface (GUI) for the courseware. 
Prior to publishing any WBT courseware, information in the “Settings” and “Slide 
Manager” of Adobe Presenter needs to be preset.  Publish WBT courseware 
after this information has been correctly inputted and saved. 
Courseware may be published locally or to an Adobe Connect Pro external 
server.  Where the courseware is published depends on what the developer is 
trying to accomplish.  See Section 1.4 of this guide for more specific guidance on 
where to publish content during the WBT development process. 
Published courseware is referred to in the Adobe Presenter environment as 
“Content.” 

9.1. Presentation Settings  

9.1.1. Theme Editor Settings 
Theme editor settings should be set prior to publishing courseware. The settings 
can be saved and reapplied to the same product or new products as needed. 
 
1. Open the Presentation Settings window by selecting Adobe Presenter  

Settings. 
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2. Select Appearance tab. 

3. Enter “Module {title}” in the Title field. 

4. Select Theme Editor button under Themes to open the Theme Editor 
window. 
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5. Select Save as… button and enter “NHI Theme I”. 

6. Select  Enable Mode Switching the following under Customize. 

 Select “Default” from the Display dropdown. 

5. Select Show Sidebar. 

 Select “Right” from the Location dropdown. 

6. Deselect all boxes under Presenter Info. 

 Select the Outline Pane Checkbox 

7. Select Outline, Notes, and Search under Panes. 

8. Select “Notes” from the Default dropdown. 

9. Select “Verdana” from the Notes Pane Font dropdown. 

10. Select “10” from the Size dropdown. 
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11. Select Modify Text Labels button under Appearances. 
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12. Enter “Narration” for Notes tab text in Custom Text column. 

13. Select Okay to return to Theme Editor window. 
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14. Select each colored box under Appearance. 

15. Enter the following settings under More Colors or select the color indicated. 

 Theme: Hue: “140”, Sat: “240”, Lum: “48”, Red: “0”, Green: “51”, 
Blue: “102” 

 Glow: Hue: “108”, Sat: “25”, Lum: “195”, Red: “202”, Green: “212”, 
Blue: “209” 

 Font: “White” 

 Background: Hue: “75”, Sat: “8”, Lum: “110”, Red: “114”, Green: 
“121”, Blue: “113” 

16. Select OK to return to the Theme Editor window after adjusting each color 
setting. 
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9.1.2. Additional Presentation Settings 
17. Select Playback tab. 

18. Select Auto play on start and Include slide numbers in outline. 
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19. Select the Quality tab.  

20. Select “Adobe Connect Pro” in the Publish for dropdown. 

21. Select Publish Audio and CD Quality under Audio Quality. 

22. Select High under Image Quality. 

23. Deselect Control Preloading. 

24. Select Use these settings for new presentations. 
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25. Select the Attachments tab. Here you will attach a PDF version of the 
presentation. If you have not done so already, create a print-ready PDF 
version of the presentation in notes view. 
 Ensure all text in the notes will fit on the slide in notes view. 

26. Select the Add button.  

27. Enter “Module {x} PDF” in the Name field. 

28. Select “File” in the Type field. 

29. Select the file folder icon.  

 Navigate to the PDF and select it.  

 Choose the Open button to select the PDF.  

 Select OK to save the attachment in the Location field. 

30. Select OK to save your settings and exit the Presentation Settings. 
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9.1.3. Slide Manager Settings 
Before publishing the PowerPoint file, modify the Slide Manger settings as 
follows.  
 
1. Open the Slide Manager window by selecting Adobe Presenter  Slide 

Manager. 

 
 

2. Choose the Select All button. 
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3. Select the Edit button. 
4. Select Advance by User. 
5. Select the OK button.  

 All of the slides should now say “yes” next to Advance by User. 

6. Select OK to save the settings and exit Slide Manager. 
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10. Delivery Formats  
NHI shall hold ownership of the final courseware (source files), including the 
PowerPoint files and all final and raw audio, video, Flash (.FLA), and graphic 
files.   
Deliverables for WBT courses are electronic files. Deliver the products required 
by the contract as final deliverables in the following formats.   
 CD-ROM of all source files, including 

− Presentation and exam in Microsoft PowerPoint 2007 or later format 
(may be segmented by module or lesson if files are large) 

− Adobe .ppc files or raw audio files, such as .wav or mp3 

− Video as compressed digital files in .flv or .avi 

− Animation in Flash as .fla 

− Other resource materials, such as spreadsheets or tables, that are 
accessed via external links 

− Graphics as compressed, processed files and .psd with layers 
preserved 

 CD-ROM in .PDF format (marked with “P” on the CD label) 

− Presentation materials (provided print-ready as separate files for 
each module-this file should also be attached to published file) 

− Reference manual (provided print-ready as one complete document) 

− Other materials required for course delivery 
 Published files 

− Adobe .ppx files (published presentation) 

− Adobe .ppc files (published audio) 
 Copies of all copyright releases and letters granting permission for use 

from the authors or artist, if applicable 
 Any written approvals for modifications 
 

10.1. CD-ROM Labels 
 U. S. Department of Transportation/Federal Highway Administration logo 
 NHI logo 
 Publication number 
 Date (month and year) 
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 NHI course number 
 NHI course title 
 Type of document (e.g., facilitator guide, participant workbook, reference 

manual) 
 IACET logo (if applicable) 

The publication number is specific to each course deliverable and provided to the 
contractor by the NHI TPM or ISD. 

10.1.1. Use of Logos and Company References 
 Company logos will not be included on any deliverable to NHI. 
 References to the company and/or persons developing, designing, and/or 

delivering the course will not be included in any PW, IG, RM, or visual aids 
(exceptions must be documented on Technical Report Documentation 
Page).   
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11. Standards for Electronic File Submissions 
The U.S. Department of Transportation (DOT) Standard indicates that all printed 
materials, including visual aids, must be developed using Microsoft Office 2007 
(or later) format. This requirement allows NHI to edit all documents delivered by 
the developer. 
 Note that NHI currently accepts Microsoft Office 2007 or later versions.  
 Documents should not be delivered in read only, presentation- only, or 

password protected format. 
 The use of macros and other complex formatting should be kept to a 

minimum. 
Use the requirements below to create folders for files delivered to NHI.  

11.1. Source Files Folder 
 Presentation Materials 
 Reference Manual 
 Test Materials 
 Supplemental Materials 

11.2. PDF Files folder 
 Presentation Materials  
 Reference Manual 
 Supplemental Materials 

11.3. Readme File 
 If a course shares materials with another course, document that need in 

the readme file.   
 Additional information on use of materials or printing requirements is 

included in this file, as well. 

11.4. File Naming Conventions 
Following are file naming conventions for each deliverable. Separate each item in 
the file name with an underscore (_). 
 Course number 
 Publication Type  
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− RM (reference manual) 

− PP (PowerPoint presentation)  

− EX (exam, test, assessment, evaluation instrument, answer key)  

− SM (simulation)  

− VD (video)  

− AU (audio)  

− BK (book)  

− OM (other materials)  
 Publication number (if applicable) 

− Obtain from NHI (XX-XXX) 
 Revision date formatted in a two-digit month and year 

− 0511  
 File Description (short description of the file, if necessary)  

− ExamA  

− ExamB  
 Application Extension 

− PDF (Adobe Acrobat) 

− DOC (Microsoft Word) 

− PPT (Microsoft PowerPoint) 

− PPC (Auto-generated audio file by Adobe Presenter) 

− WAV or MP3 (Audio file)  

− .FLV or .AVI (Video file) 

− If use of other software has been approved, use standard application 
extensions  

Following are two examples of file names using the convention Course 
Number_Type_Pub #_Date_Desc. 

 130053_PW_09-116_0511.pdf 
 141031_EX_0702_TestA.doc (an example where no publication number 

will be assigned) 
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